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Introduction and Overview 
DataInsight-Web is browser-based data navigation and retrieval tool, with desktop-class performance.  

You can use DataInsight-Web to: 

• Find the data you need. 

• Browse, view, save, and export from a library of service-specific, pre-defined tables. 

• Save your data in workbooks. 

• Share your data with colleagues 

• View and pivot data on-screen. 

• Export data to Excel. 

• Apply Functions to data. 

Additionally, powerful applications and smart datagroups are also available for use in DataInsight-
Web, depending on your subscription: 

• Cost Analyzer allows you to tactically analyze a single buy or strategically evaluate an entire 
supply chain performance to know if your suppliers’ prices are inflated or not.  

• Purchasing Analyzer provides access to select industry concepts and allows you to break 
out industry input costs.  

• Smart Datagroups provide access to multi-dimensional databases of IHS Global Insight 
data. 

Documentation and Support 

For the most up-to-date information about DataInsight-Web, and our business in general, check our 
web site, www.IHS.com. 

For telephone support: In the United States, contact the Client Resource Center at 1-800-933-3374. 
Outside of the United States, please contact your sales representative. 

For email support, send your request to CustomerCare@ihs.com. 

http://www.ihs.com/
mailto:customercare@ihs.com
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Finding and Selecting Data 
Use keyword and category search to find series to view, export, or store in a workbook. 

To begin a keyword search, click on the Keyword Search selection under “Forecast” or “Historical” in 
the left-hand navigation pane. The keyword text box then appears for you to enter your search term 
or phrase.  

 

There is also a Keyword Search under the “Selected Criteria” pane to further filter your results. 

 

Keyword searching is a technique that allows the search for the occurrence of words in time series 
documentation. A keyword is a word or phrase found in the documentation that identifies it to you in 
some way. 
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Keyword Search 

Basic Search 

To perform a basic search, enter partial or full words or expressions in the Search field and press 
“Enter” or click “Go.” The search results appear in the columns below. 

 

Advanced Search 

You may add additional criteria to narrow your search by clicking on the “Advanced” link when you 
select a “Keyword Search” option in the Navigation pane.  

 

Using this feature with a keyword or phrase, you can select a specific Data Source, Mnemonic or 
partial mnemonic, Frequencies, and one or more banks from a bank list. 
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Search multiple banks by using Shift-click (to select adjacent banks) and Ctrl-click (to select individual 
banks). 

 

Category Search 

Use category search to find series based on specific criteria such country, industry, concept, brand, 
or vehicle type. 

DataInsight-Web Datagroups  

Related series are grouped into datagroups, Smart datagroups, or categories such as U.S. Regional, 
Global Economy, and Financial Markets. The actual categories available to you will depend on your 
specific IHS Global Insight subscription. 
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Building a Category Search by Criteria Selection 

 

To retrieve time series data: 

1. Pick a Datagroup, and the Available Criteria drawers will appear for that source. 

2. Click on the checkbox in front of your selections, and they will appear in the Selected 
Criteria panel on the right. 

3. Optionally, filter frequencies and scenarios by making selections from the corresponding 
buttons on the right. 

 and  

4. Now click on Go to view the results of your query. 
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Table Browser 

The Table Browser allows you to browse, view, save, and export from a library of service-specific, 
pre-defined tables.  

Using the Table Browser: 

1. Make your selections from left to right by clicking on them once. As you click, a list of choices 
for each selection appears in a new column to the right as you drill down to see available 
tables. 

2. When a table is selected, a new column appears with information specific to the table. This 
information includes the name of the table, a brief description, the frequencies that are 
available for the table, and the number of versions available. 

3. To view the table on screen, simply press "View Table". 

 

Table Browser Actions 

Save 

 

This option saves a table in your “Saved Items” area for quick access in future sessions. 

When you click the Save icon, a dialog appears for you to either select a destination folder for your 
saved table. This dialog also allows you to create new folders. 
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To create a new folder: 

1. Click “New Folder.”  

2. Name the folder in the textbox that appears in the Tables list (see above).  

3. Click “Save” and your saved table will appear in DataInsight-Web in its new folder. 
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Export 

 

This option allows you to export the current table into an Excel workbook. Depending on your browser 
configuration, you may be prompted to open or save the Excel document. 

 

Hide/Show Table 

  

This option alternately hides and shows the current table on your screen.  

Note: Hiding the table will give you more space to view the library of available tables. 

Date 

 

Set amount of history and forecast 
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Select the date range using a number of years, quarters, months or observations in the past and in 
the future. Note: This selects the date range relative to TODAY -- it does not determine the data edge 
of individual series. 

Custom 

Start Date 

 

First available value: Select to export time series data, beginning with the first observation 
of the data that exists in our database. 

Number of values before or 
after today: 

Enter the number of observations, years, quarters, or months to 
export, starting with today and going back into time for historical data 
or ahead into the future for forecast data. 

Number of values up to end 
date: 

Enter the number of observations, years, quarters, or months to 
export, going back into time from the end date you specify in the 
following section. 

Fixed Date: Enter an end date or select it by clicking once on the date and using 
the calendar tool provided. 

 

End Date 
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Last value: Select to export time series data, ending with the last observation of 
the data that exists in our database. 

Today: Select to use today’s date as the end date. 

Number of values before or 
after today: 

Enter the number of observations, years, quarters, or months to 
export, starting with today and going back into time for historical data 
or ahead into the future for forecast data. 

Fixed Date: Enter an end date or select it by clicking once on the date and using 
the calendar tool provided. 

 

Columns 

 

Use the “Columns” button, at the bottom of the screen, to display the Custom Columns dialog where 
you can add, remove, and reorder the columns you would like displayed for your series. You can 
change the selected columns by drag-and-drop, and you can also double-click on a column to flip it 
from right to left or vice-versa. 

 

Preferences 

 

DataInsight-Web offers many options to customize the way your data will display and export. 
Preference options are available at a global level, where defaults can be specified for the entire 
application, as well as at the workbook level, where an individual workbook may have its own unique 
settings. (See Preferences and Settings for more information.) 
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Viewing Data 
After you click "Go", the results of your category search will appear in the columns in the middle of the 
page.  (See Keyword Search for information about keyword searching. 

 

Preferences for Exporting Data 

If you want to set your preferred download settings as defaults or customize the settings for a specific 
workbook, see Preferences and Settings for information on customizing these settings.  

The following sections will show you how to: 

• Rearrange, add, or remove data columns using the Columns button.  

• Select series to graph and view the information.  

• Switching between the series list and the data table. 
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Customizing the Results (Data) Columns 

 

Use the Columns button, at the bottom of the page, to display the Custom Columns dialog. There you 
can drag and drop the buttons to add, remove, and rearrange the result columns before or after you 
retrieve your results. 
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Note: Not all the columns listed below are applicable for all data. 

Column Description 

 Name of the categorized database associated with the series. 

 Benchmark date for the index calculation. 

 Manufacturer or trade name. 

 
Economic or Financial concept definition of the series. 

 
Series name assigned using the legacy DRI naming convention. 

 Last historical data period for forecast data. 

 The date of the last observation of time series data. 

 Number of time intervals of the time series expressed as “Daily” 
through “Annual.” 

 Country or defined region for the time series. 

 Representation of a specific industry or sector for the series. 

 Date the time series data was last updated with new values and/or 
revisions. 

 Detailed description of time series. 

 When present, indicates whether a time series is real or nominal. Valid 
values are “Real,” “Nominal,” or “NA.” 

 Denomination of the unit. Indexes are not scaled.  For some forecast 
data, scale and unit are combined in the “Unit” column. 

 When present, indicates whether a time series is seasonally adjusted. 
Valid values are “SA,” “NSA,” or “NA.” 

 Indicates whether a time series is historical or forecast.  This column 
often includes forecast details indicating what type of forecast series it 
is. 

 Abbreviated form of the “Long Label.” 

 The organization from which the data is obtained. 

 The date of the first observation of time series data. 

 Standard of measurement, e.g., currency, percentage, index, and 
exchange rate. For some forecast data, scale and unit are combined in 
this column. 

 Series name assigned using the legacy WEFA naming convention. 
 

 

 No longer applicable. This column will be removed in a future release. 

 No longer applicable. This column will be removed in a future release. 

 No longer applicable. This column will be removed in a future release. 

 
No longer applicable. This column will be removed in a future release. 
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To expand a result column’s width, place your cursor on the line between the column headings slowly 
until it displays as a two-sided arrow (shown in a red box below). After that, drag the column to the 
right until it becomes the desired size. 

 

Series Graph/Information Display 

    

At the bottom left of your screen, there is a dual-purpose panel for displaying a graph or information 
for one or more series that you select in the results area.  

 Displays a graph of the selected series (you can choose up to 5 series for 
your graph). 

 Displays time series information for the most recent time series you have 
selected. 

To graph series: 

1. Select a series by clicking on it. (Use Shift-click or Ctrl-click to select multiple series.) 

2. Each series (up to 5) will appear as a different line color in the chart. 
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Switching from the Series List to a Data Table On-screen 

 

The View Data Table option of the workbook context menu displays the Data Table within the 
selected workbook with the series data in it. Alternately, you can click on the Data Table tab above 
the column headers of the series list to display the table. 

 

On the Data Table tab, the series in the table can be grouped by using the drop-down list at the 
bottom of the screen. 
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Option Icons for the Series List and the Data Table Views 

Tab Icon Description 

Series List     

 

Depending on your browser configuration, you may be prompted to 
open or save the Excel document. 

Exports the selected series of the open workbook to Excel and opens 
Excel when you choose the Open button. If you choose the Save 
button, you will be asked to select the location for naming and saving 
the workbook. 

 

 

Depending on your browser configuration, you may be prompted to 
open or save the Excel document.  

Exports all series of the open workbook to Excel and opens Excel 
when you choose the Open button. If you choose the Save button, 
you will be asked to select the location for naming and saving the 
workbook. 
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Tab Icon Description 

 

 

Allows you to apply functions to selected time series and to replace 
the line item or add an additional line to the table containing the 
function. 

See Applying Functions to Data for more information. 

 

Allows you to add new series to the series list. This feature opens the 
Add Series by Mnemonic dialog and allows you to type or paste 
series mnemonics into it.  

This feature also verifies that the mnemonics that you add are correct 
by looking for them in our database and in the series list before 
added them there. 

 

 

See Applying Series to Workbooks by Mnemonic for more 
information. 

Data Table     

 

Depending on your browser configuration, you may be prompted to 
open or save the Excel document. 

Exports the series of the open workbook to Excel and opens Excel 
when you choose the Open button. 
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Tab Icon Description 

 

 

 

Toggles the orientation of the table. 

Values Down: 

 

Values Across: 

 

 

Displays the table in a new window without the browser menu or 
toolbars. 

 

When available will group or ungroup the data values on the Data 
Table tab. 
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Sharing Items 
The “Sharing” options under Global Preferences allow you to share your saved Items with your 
colleagues.  Sharing workbooks is only possible if your global preferences are set correctly. 

 

 

Look for Shared Items 

 

When you select the check box in this pane, shared items appear as branches under the names of 
your colleagues at the bottom of the navigation pane.  You can view shared items even if you have 
your own sharing off. 
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When you clear the check box in this pane, no shared items appear in the navigation pane.  

 

Note about Billing Codes and Sharing: The billing code comes from the source workbook when the 
source workbook has a workbook-level billing code specified, using the button at the bottom of the 
screen.  

Examples: 

Scenario 1 

You set the billing code at the workbook level and the billing code appears on the “Advanced” tab for 
workbook settings. 
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Scenario 2 

You assign a billing code to all your workbooks as a default, using global preferences, and the billing 
code appears on the “Advanced” tab. 

 

 

When you share this workbook, other users will see nothing in the “Billing Code” field when they look 
at the workbook settings. 

 

 

Sharing is ON/OFF 

 

When you turn sharing on in this pane, your colleagues will see the items that you have marked for 
sharing.   
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To mark a workbook for sharing, right click on it in the navigation pane and select “Share this item” 
from the context menu that appears. Your shared items will appear in the lists of your colleagues. 

 

To stop sharing, right click on the item again and select “Stop sharing this item.” 

 

When you turn sharing off in this pane, your colleagues cannot see the items that you have marked 
for sharing. 
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Saving Data 

Workbooks  

Workbooks are containers you can create to save, organize, and manage time series. 

To create a workbook manually: 

1. Once you find the time series you want (see Finding and Selecting Data for more 
information), select one or more of them and click on the “Save Selected” button at the 
bottom of the webpage.  

 

To save all results, click “Save All” without selecting anything. Either action will display a 
Browse Workbook dialog for you to save a new workbook in the Data Sources pane. The new 
workbook will appear with the name selected and ready for you to type the workbook name.  

(Hint: You can also right-click in the workbook area and select "Save" or "Save All" from the 
menu that appears.) 

 

2. To set the name, press Enter. To open the workbook, click once on it in the Workbooks data 
tree.  

 

Note: The number of series in a workbook will appear in a tool tip as you hover over the 
workbook’s name. 

Once the workbook is opened, you can  
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• Rename it by clicking once on it in the workbook data tree. 

 

• Use the Settings button to change the settings for a specific (open) workbook, overriding 
the defaults set on the global Preferences tab.  

 

These settings will remain in the workbook until you change them. (See Preferences and 
Settings for more information.) 

  



DataInsight-Web v4.3 User Guide Saving Data 

 

 30 

Using the Context Menu for Workbooks 

Right click on a workbook in the Workbooks tree to display a context menu of the most often-used 
commands. 

 
 

Command Description 

Delete Removes the workbook and its contents completely. You will receive a confirmation 
window before removal. Alternately, you can select the workbook and use your delete 
key. 

 

Copy Makes a copy and places it at the bottom of the workbook tree.  

 

Rename Displays the name of the selected workbook in an editable field for adjustment. 
Alternately, you can change the name in the Workbook Name field within the workbook. 
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Command Description 

Move Displays the Browse Workbook dialog box with the workbook tree in it. To move a 
workbook’s position under another, select the workbook that will be immediately above it 
and then click OK. Alternately, you can drag-and-drop the name into the desired position 
in the tree, as shown. 

 

Share this 
item 

Allows you to share a workbook with your entire work group and displays a shared 
workbook icon in front of it. 

 

To remove sharing, right click the workbook again and select “Stop sharing this item.” 
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Command Description 

Export Depending on your browser configuration, you may be prompted to open or save the 
Excel document. 

 

Note: When you click “Save,” a “Save as” dialog box will appear for you to save your 
workbook to your system. 

View Data 
Table 

Displays the Data Table page with the series data in it. Alternately, you can click on the 
Data Table tab in the workbook to see the table.  

 

Once displayed, the series in the table can be grouped by using the drop-down list at the 
bottom of the page, as shown. 
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Working with Series in a Workbook 

You can copy and delete series in a workbook via a right-click context menu or by drag-and-drop for 
copying and by using your Delete key for removal. You must use the context menu to move series 
from one workbook to another.  

You can also add series to a workbook manually by using mnemonics. (See Adding Series to 
Workbooks by Mnemonic for more information.) 

Note: Workbooks can contain a maximum of 1000 series. 

Using the Context Menu for Series in a Workbook 

To use the context menu for the series in a workbook, select one or more series and then right-click 
for the menu. 

 

When you move or copy series using this menu, a “Browse Workbooks” dialog box appears for you to 
choose the target workbook from a list or create a new workbook as the target. After you move or 
copy, both workbooks in the Workbooks panel display disk icons as they are automatically saved. 
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Adding Series to Workbooks by Mnemonic 

DataInsight-Web has a feature that lets you add series to a workbook using series mnemonics. 

To add series by mnemonic to a workbook: 

1. Select a workbook on the left and it will open to display the series contained in it. 

 

2. Click Add Series and a dialog box will open for you to enter the mnemonics of the series to 
be added to the open workbook. Press Enter after typing each series to go to the next line.  
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Alternately, you can paste a list of series, copied from a text editor like Windows Notepad, 
into the dialog by using the right-click context menu available there. 

 

 

3. Click Add and a Results dialog will appear.  

 

4. Click OK to complete the process and the additional series will appear in the workbook. 
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Applying Functions to Data 
You can apply a function to a time series and either replace the time series or add a line with the 
function underneath the target series.  

To apply a function to a series: 

1. Select one series in the Series List by clicking on it or, to select multiple adjacent series, use 
Shift-click or, to select multiple non-adjacent series, use Ctrl-click. 
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Function Definitions 

Percent 
Change: 

The change in data, from one period to another, expressed as a percentage of its 
value in the first of the two periods. 

PCH(x) 

Percent change of x lag 1 

(x/x.1 - 1)*100 

Percent 
Change Year 
Ago:  

The percentage change in data from a year ago. 

PCHYA(x)  

Annual percent change of x 

(x/x.p - 1)*100 

p is the number of periods in each year 

Percent 
Change Year 
Ago Moving 
Average: 

The percent change of a moving average is a method for smoothing data by 
averaging a fixed number of consecutive years and then calculating the percentage 
change of the data from the previous year-over-year moving average. 

PCHYA(MOVAVG(n, x)) 

Percent change year ago of the moving average of x lag n. 

Percent 
Change 
Annualized: 

The smoothed year-over-year growth rate of a value over a specified period of time 
(CAGR). 

Compound annual growth rate of x lag 1  

((x/x.1)**p - 1)*100 

p is the number of periods in each year.  

Natural Log: Returns the natural logarithm of X, using a base of 2.71. 

LOG(x) 

Convert Daily 
to Weekday: 

Converts seven-day data to five-day data by eliminating the data for the weekend. 

Daily(Mon - Sun) to Weekday(Mon - Fri)  

Convert to: Annual, Quarterly, Monthly 

Convert(series, method) 

This function can Interpolate a lower current frequency to a higher one, i.e., Annual to 
Monthly: 
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Method Example 

Spline Convert(GDP.A, Spline) 

Prorate Convert(GDP.A, Prorate) 

Linear Convert(GDP.A, Linear) 

Geometric Convert(GDP.A, Geometric) 

Repeat Convert(GDP.A, Repeat) 

AND 

This function can Collapse a higher current frequency to a lower one, i.e., Quarterly to 
Annual: 

 

Method Example 

Average Convert(GDP.Q, Average) 

First Convert(GDP.Q, First) 

Last Convert(GDP.Q, Last) 

Maximum Convert(GDP.Q, Maximum) 

Minimum Convert(GDP.Q, Minimum) 

Range Convert(GDP.Q, Range) 

Spread Convert(GDP.Q, Spread) 

Total Convert(GDP.Q, Total) 
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Compound 
Annual 
Growth 
(Lagged n 
periods): 

 

CAGR(n, x) 

Compound annual growth rate of x lag n 

((x/x.n)**(p/n) - 1)*100 

p is the number of periods in each year 

2. Click on the Function button at the bottom of your screen and make your function selection. 

3. (Optional) Un-select the Replace selection option if you want to see each series you selected 
repeated with the function applied to it as a separate row. 
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Exporting Data to Excel 
You can export category and keyword search results or the contents of a workbook into a Microsoft 
Excel spreadsheet to open and work with and/or to save on your system for later use.  

Exporting Category Search Results 

To export category search data or workbook data to Excel: 

1. Select one series in the Series List by clicking on it, or to select multiple adjacent series, use 
Shift-click or, to select multiple non-adjacent series, use Ctrl-click. 

 

2. Select either the Export Selected or Export All option.  

Note: when selecting Export All, it is not necessary to make series selections first. 
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3. Depending on your browser configuration, you may be prompted to open or save the Excel 
document.  

 

If you select “Open,” Excel will display a preformatted table that you can adjust using Excel 
functionality, and then print or save. 

 

If you select “Save,” a Save As dialog box appears for you to save the workbook, after 
renaming it if necessary, to any location on your system.  
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Refreshing a DataInsight-Web Workbook in Excel 

You can update your workbook in Excel 2003 using “External Data” toolbar and in Excel 2007 using 
the “Data” tab. 

You also can disable this feature on the “Advanced” tab under the Preferences menu option.  

 

Accessing the External Data toolbar in Excel2003 

To display the External Data toolbar in Excel 2003, if it does not appear in the Excel toolbar area, 
use the View > Toolbars > External Data menu options. 
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Accessing the Refresh All Feature in Excel 2007 

To refresh workbook data in Excel 2007, use the “Refresh All” option on the Data tab. 

 

Refreshing Data in Excel 2003 and 2007 

To refresh the DataInsight-Web data in an Excel workbook: 

1. After making modifications or opening a previously saved DataInsight-Web workbook, click 
the “Refresh” button on the External Data toolbar in Excel 2003, or click on “Refresh All” on 
the Data tab in Excel 2007, to pull in the latest data. 

 

OR 

 

Note: (For Excel 2007 only) When you export a Workbook to Excel 2007 you will see a 
Security Warning alert.  Click “Options,” click “Enable this content,” and then click “OK.” 
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2. Login with your MyInsight credentials. You only have to do this once per Excel 2003 or 2007 
session. 

 

3. If you exported a smart workbook containing a single tab, current data will be pulled in and 
the refresh process will be complete. 

If you exported a workbook containing multiple tabs, a download link will display. Click it 
ONCE as it indicates and go on to step 5.  
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4. Click “OK” to open the refreshed copy of your workbook. 

 

A status screen will appear. 

 

5. Current data will appear in an updated, read-only copy of your workbook (if it has multiple 
tabs). 

 

Save the [Read-Only] copy under a different workbook name and it will be editable. 

Note:  If you delete rows or columns of data after exporting your data to Excel, these will 
reappear after you refresh. 
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Preferences and Settings 
DataInsight-Web offers many options to customize the way your data will display and export. 
Preference options are available at a global level, where defaults can be specified for the entire 
application, as well as at the workbook level, where an individual workbook may have its own unique 
settings.  

Preferences and Settings Overview 

 

OR 

 

Use “Preferences” to set global defaults for all workbooks. 
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When you have a workbook selected, use “Settings” to specify settings for it only, 
overriding any global default settings for all workbooks. 

 

Most options can be set at either the global or workbook level.  

Note that at the workbook level you can choose to use application defaults, or to use 
settings specific to a workbook. 
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Global Preferences and Workbook Settings Explained 

Tab Option and Description 

Export Style 

 

Formatted 

This style displays a table that has formatting applied to it to make it more 
attractive and easier to see the column and row headers. Results are 
grouped, with each "grouping item" having its own row header with the 
members of the group below it. (Example: If grouping by country, there will 
be a row with the name of the country and the following rows will contain 
the series for that country.) Data that has "Data Edge" information 
associated with it will be displayed according to the Highlight Forecast 
selection of the Format tab. 

Plain 

This style is an Excel spreadsheet without formatting, and is recommended 
when the sheet is being used programmatically or as the input to another 
process, where style information and grouping could be a problem. With 
plain style, each "grouping item" does not appear on a row by itself (like in 
Formatted). Instead, the grouping items are repeated in their own column, 
so each row has this information. 

 Location 

 

The cell location (row number and column number) is where you would like 
the data to start in the generated Excel document. 

Format Orientation 

 

Indicate whether you want values in rows or columns by making a selection 
here. 

 Decimal 
Places 

 

Select the number of decimal places to be displayed. 

  Note: When exporting data, full values will be exported to Excel. This 
setting determines the format Excel will apply to the data. Once in Excel, 
data can be reformatted to show additional decimal places. 
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Tab Option and Description 

 Display 
dates as 

 

For dates that do not pertain to a single calendar day, such as "2000 Q1" or 
"2000", select whether these dates should be passed to Excel as the start 
or end of the period in question. 

Example:  

For 2001 Q1 data, export this to Excel as 1 Jan 2001 (start of period) o r 31 
Mar 2001 (end of period). 

 Highlight 
forecasts 

 

For data where a "data edge" is reported, this preference lets you display 
forecast values in the highlight color of your choice for both DataInsight-
Web tables and Excel spreadsheets after you export them. 

Date 
Range 

Set amount 
of history 
and forecast 

 

Select the date range in a number of years, quarters, months or 
observations in the past and in the future. Note: This selects the date range 
relative to TODAY—it does not determine the data edge of individual series. 

 Custom Start Date 

 

First available value: 

Select to export time series data, beginning with the first observation of the 
data that exists in our database. 

Number of values before or after today: 
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Tab Option and Description 

Enter the number of observations, years, quarters, or months to export, 
starting with today and going back into time for historical data, or ahead into 
the future for forecast data. 

Number of values up to end date: 

Enter the number of observations, years, quarters, or months to export, 
going back into time from the end date you specify in the following section. 

Fixed Date: 

Enter an end date or select it by clicking once on the date and using the 
calendar tool provided. 

 
 

End Date 

 

Last value: 

Select to export time series data, ending with the last observation of the 
data that exists in our database. 

Today: 

Select to use today’s date as the end date. 

Number of values before or after today: 

Enter the number of observations, years, quarters, or months to export, 
starting with today and going back into time for historical data or ahead into 
the future for forecast data. 

Fixed Date: 

Enter an end date or select it by clicking once on the date and using the 
calendar tool provided. 
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Tab Option and Description 

 

Advanced Default 
order for 
Category 
Search  

When ordering series by concept (by clicking on the column header to sort 
ascending or descending), the default behavior is to sort alphabetically. This 
control lets you change the sorting behavior so that sorting is not done 
alphabetically, but is done by the order of the concept in “Available Criteria” 
in category search. 

 

For example, if concepts appear in category search in "Available Criteria" 
in this order—Sales, Cost of Goods Sold, Gross Profit, Expenses, Net 
Profit—this preference, when set for "Concept (Order in Tree)," will display 
results in this same order, not alphabetically. 

 Display 
mnemonics 
preferences 

 

When there are series that have both a DRI and WEFA series name (i.e., 
the series have been merged), this selection allows you to set which name 
you want displayed. 
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Tab Option and Description 

 

 

 

 

 

Note: Click on “Go” to refresh the mnemonics if you change the display 
preference of series already appearing in the results list. Only the merged 
series will display differently (as in the examples above). 

 Non-
Refreshable 
Sheets 

 

When exporting a workbook, DataInsight-Web creates Excel documents 
that can be updated directly within Excel using Excel’s built-in “External 
Data” toolbar. Check this box to disable this feature.  (See Exporting Data 
to Excel for more information.) 

http://myinsight.ihsglobalinsight.com/servlet/cats?documentID=2266449&serviceID=22215&pageContent=help
http://myinsight.ihsglobalinsight.com/servlet/cats?documentID=2266449&serviceID=22215&pageContent=help
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Tab Option and Description 

 Billing code 

 

An optional billing code, which is recorded during your data usage and can 
be used to track data usage for billing purposes, for those users that accrue 
data usage related charges. 

 

Note about Billing Codes and Sharing: The billing code comes from the 
source workbook when the source workbook has a workbook-level billing 
code specified, using the button at the bottom of the screen.  

Examples: 

Scenario 1 

You set the billing code at the workbook level and the billing code appears 
on the “Advanced” tab for workbook settings. 

 

 

Users that share this workbook with you will see your billing code on its 
“Advanced” tab for workbook settings:  

 

Scenario 2 

You assign a billing code to all your workbooks as a default, using global 
preferences, and the billing code appears on the “Advanced” tab. 
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Tab Option and Description 

 

When you share this workbook, other users will see nothing in the “Billing 
Code” field when they look at the workbook settings. 

 

 

 Rows per 
page 

 

Select the number of rows, from 10 to unlimited, which will be returned by 
search.  

Note that search results are limited to 1,000 series and DataInsight-Web will 
display an alert to indicate how many results it finds. 

 

Sharing Look for 
Shared 
Items 

 

When you select the check box in this pane, shared items appear as 
branches under the names of your colleagues at the bottom of the 
navigation pane. 
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Tab Option and Description 

 

When you clear the check box in this pane, no shared items appear in the 
navigation pane.  

 

See “Billing Code” (above) for an important note about sharing. 

 Sharing is 
ON/OFF 

 

When you turn sharing on in this pane, your colleagues will see the items 
that you have marked for sharing.   

To mark a workbook for sharing, right click on it in the navigation pane and 
select “Share this item” from the context menu that appears. Your shared 
items will appear in the lists of your colleagues. 

 

 

To stop sharing, right click on the item again and select “Stop sharing this 
item.” 
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Tab Option and Description 

 

When you turn sharing off in this pane, your colleagues cannot see the 
items that you have marked for sharing. 
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Cost Analyzer 
The Cost Analyzer tool allows you to tactically analyze a single buy or strategically evaluate an 
entire supply chain performance to know if your suppliers’ prices are inflated or not.  

The Cost Analyzer wizard walks you through the process of building a workbook of commodity and 
economic time series. Your workbook is saved and the data within it automatically refreshed as new 
data becomes available. 
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Using Cost Analyzer 

Here is an overview of the steps that you will find in the Cost Analyzer wizard: 

1. Give the date range and frequency of the time series data. 

 

2. Select series by entering a commodity group keyword and/or a mnemonic, or by selecting the 
branches and nodes of the data tree directly. 
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3. Select any percent change type statistics that you want to have applied to the selected series 
and how you want the output grouped. 

 

4. Select if you want a composite index, name it, make your selections and apply weights to it. 
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5. Save your workbook to create or download it directly into an Excel workbook. 
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Saving Your Workbook 

 

When you click “Save,” you have the option of loading the table into DataInsight-Web by clicking 
“Take me there,” or not by clicking “Close.” 
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In DataInsight-Web, you can change the name of the workbook, name and modify your index if you 
selected one, and manipulate the table easily using the options provided. 

 

See Preferences and Settings, Exporting Data to Excel, and Applying Functions to Data for 
more information about the Cost Analyzer screen elements. 
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Purchasing Analyzer 
The Purchasing Analyzer provides fast access to select industry concepts and allows you to 
breakout industry input costs. 
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Using Purchasing Analyzer 

Here is an overview of the steps that you will find in the Purchasing Analyzer wizard: 

1. Give the date range and frequency of the time series data. 

 

2. Find an industry by entering an industry keyword or by moving down the branches and nodes 
of the data tree directly and select it. 
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3. Select concepts to apply to your selected series. 

 

4. Select any statistics to apply to your selected series. 
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5. Select Download for workbook creation and select to open or save the Excel workbook using 
the dialog that appears. 

 

 

6. Close the Download dialog to return to DataInsight-Web. 
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Using Smart Datagroups 
A Smart Datagroup is a categorized data set designed to support enhanced features for additional 
analytics such as currency conversion and rebasing, multi-dimensional data display sorted by user 
defined criteria and statistical ranking.  

As a subscriber to a smart datagroup, you have more options available to you than our regular 
workgroup subscribers. A smart datagroup pulls data, derived from several sources, directly from the 
IHS Global Insight database. 

Previewing Smart Datagroup Layouts 

The smart datagroup layout icons help you customize the display of your preview.  

 

Icon Mode How it looks… 

 
Tab 
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Stacked 

 

 
Side-by-side 

 

  



DataInsight-Web v4.3 User Guide Using Smart Datagroups 

 

 69 

Smart Datagroup Options 

Smart datagroup features allow you to apply functions to your data, export your data and selected 
formatting to a new or existing Excel workbook, refresh your data with the latest information, and save 
your criteria for use over subsequent smart datagroup sessions. 

A smart datagroup, like World Industry Service or WIS, pulls yearly data, derived from several 
sources, directly from the IHS Global Insight database. 

 

Smart Datagroup Icons and Options 

Options available when a smart datagroup is selected: 

 

Options available when a smart workbook is selected: 
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Icon/Option What it does… 

 

Allows you to apply functions to your data. 

 

 

Function Definitions 

Base Value: The raw data. 

Percent Change: The change in data, from one period to another, 
expressed as a percentage of its value in the first of the 
two periods. 

PCH(x) 

Percent change of x lag 1 

(x/x.1 - 1)*100 

Moving Average: A method for smoothing data by averaging a fixed 
number of consecutive years. 

MOVAVG(n, x) 

Moving average of x lag n 

Compound Annual 
Growth Rate: 

The smoothed year-over-year growth rate of a value 
over a specified period of years. 

CAGR(x) 

Compound annual growth rate of x lag 1  

((x/x.1)**p - 1)*100 

p is the number of periods in each year 

 

 

Allows you to open or save your data in an Excel workbook. The preview indicates 
how the worksheet will look. 
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Icon/Option What it does… 

 

 
OR 

 

Use the “Refresh” icon to pull the latest data into your smart datagroup when the 
preview panel displays the need for it or you see an asterisk notation after 
“Preview.” 

 

 

Allows you to save your current selections in a new or existing smart workbook 
and to create a new folder for it when desired. 
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Icon/Option What it does… 

Note: A quick way to save your selections on the fly is to create a smart workbook 
and keep it selected before you make your selections.  

 

Select whether you want to group your output in your report by criteria. Note that 
you can select a tabular display of criteria using the “Sheet by” list. 

 

Select to rank your output by data. Note that “Regular” is the default selection for 
reports but you can change the default to “Ranking” using the Smart Workbook 
Settings tab within “Preferences or Settings” (explained below). 
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Icon/Option What it does… 

 
Apply functions to the data via the “Criteria” pop up list: 

 

Select functions to be applied to that data (for all rows of output).  

Select “End Date” to display the data values without a function applied. 

Function Definitions 

End Date: The last data point of your end year. 

Diff The difference between comparison values. 

Diff(x) 

Simple difference  
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Icon/Option What it does… 

x - x.1 

Percent Change: The change in data, from one period to another, 
expressed as a percentage of its value in the first of the 
two periods. 

PCH(x) 

Percent change of x lag 1 

(x/x.1 - 1)*100 

Compound Annual 
Growth Rate: 

The smoothed year-over-year growth rate of a value over 
a specified period of years. 

CAGR(x) 

Compound annual growth rate of x lag 1  

((x/x.1)**p - 1)*100 

p is the number of periods in each year 
 

 

Select the time span, by year, for your data. 

 

Smart Workbook Preferences and Settings 

DataInsight-Web offers many options to customize the way your data will display and export. 
Preference options are available at a global level, where defaults can be specified for the entire 
application, as well as at the workbook level, where an individual workbook may have its own unique 
settings.  

Subscribers to smart datagroups, like WIS, have special preference options applicable to smart 
workbooks that they create to work with smart datagroup data.  

(See Preferences and Settings for information about the other tab options available to all 
DataInsight-Web users.) 
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Icon/Option What it does… 

 
OR 

 

Use “Preferences” to set global defaults for all smart workbooks. 
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When you have a smart workbook selected, use “Settings” to specify settings for 
that workbook, overriding any global default settings for all smart workbooks. 

 

Most options can be set at either the global or workbook level.  

Note that at the workbook level you can choose to use application defaults, or to 
use settings specific to a workbook. 

Global Preferences and Smart Workbook Settings Explained 

Tab Option and Description 

Advanced Non-Refreshable Sheets  

 

When exporting smart workbooks to Excel, DataInsight-Web creates Excel documents 
that can be updated directly within Excel using Excel’s built-in External Data 
capabilities. Check this box to disable this feature. (See Generating a Smart 
Datagroup Report for more information.) 

Billing code  

 

An optional billing code, which is recorded during your data usage and can be used to 
track data usage for billing purposes, for those users that accrue data usage related 
charges. 

 

http://myinsight.ihsglobalinsight.com/servlet/cats?documentID=2267960&serviceID=22215&pageContent=help
http://myinsight.ihsglobalinsight.com/servlet/cats?documentID=2267960&serviceID=22215&pageContent=help
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Tab Option and Description 

Note about Billing Codes and Sharing: The billing code comes from the source 
workbook when the source workbook has a workbook-level billing code specified, 
using the button at the bottom of the screen.  

 

Examples: 

Scenario 1 

You set the billing code at the workbook level and the billing code appears on the 
“Advanced” tab for workbook settings. 

 

 

Users that share this workbook with you will see your billing code on its “Advanced” tab 
for workbook settings:  

 

Scenario 2 

You assign a billing code to all your workbooks as a default, using global preferences, 
and the billing code appears on the “Advanced” tab for your selected workbook. 
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Tab Option and Description 

 

 

When you share this workbook, other users will see nothing in the “Billing Code” field 
when they look at the workbook settings. 

 

 

Smart 
Workbooks 

Ranking 

 

Select to limit ranking to the top five through twenty-five rows of your table or leave 
unchecked to rank all the values without limits. 

Select ranking currency and criteria using drop-down lists. 

 

: Function Definitions for Ranking Criteria 

End Date The last data point of your end year. 

Diff The simple difference between comparison values. 

Diff = end value - start value 
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Tab Option and Description 

Percent Change The change in data, from one period to another, expressed 
as a percentage of its value in the first of the two periods.  

PCH(x) 

Percent change of x lag 1 

(x/x.1 - 1)*100 

Compound Annual 
Growth Rate: 

The smoothed year-over-year growth rate of a value over a 
specified period of years. 

CAGR(x) 

Compound annual growth rate of x lag 1  

((x/x.1)**p - 1)*100 

p is the number of periods in each year 

Note: Ranking functions are not evaluated on the values lagged by 1 period. Ranking 
always displays only two periods: start and end. The functions which determine the 
ranking are calculated always on the base of these two periods. 

 Rebasing 

 

The main objective of rebasing a series is to update the base year to a more current 
year. 

Select the base year for rebasing from the scrolling list and then choose to rebase the 
indices, real values or both. 
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Tab Option and Description 

Generic Formula for Rebasing 

Rebased_series  = series * series[old base period] / series[new base period] 
 

Note: For real monetary values it is a little bit different: 

Rebasing for Real Monetary Values 

Rebased_series  = series * LinkedNominalSeries[new base period] / series[new 
base period] 

Where “LinkedNominalSeries” is the value of the corresponding 
nominal monetary value.  

Example: For the WIS smart datagroup, "Total Sales (Gross 
Output), Real" uses the value of "Total Sales (Gross Output), 
Nominal") 

 

 Report Defaults 

 

Type 

Select whether you want to group your output in your report by dimension or rank your 
output by data. 

Layout 
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Tab Option and Description 

Select how you want your report preview format to look: either tab, stacked, or side-by-
side. (See Preview Display Layouts for more information.) 

Selected Criteria 

Select whether you want your selected criteria to be hierarchical or flat. A “Flat” 
selection is often useful for sorting the resulting data. 

Hierarchical: 

 

 

Flat: 

 

 

Frequency Visualization 

Select whether you want your frequencies to display as mixed or separate. 

Example of “Mixed” Frequency Visualization: 

http://myinsight.globalinsight.com/servlet/cats?documentID=2267957&serviceID=22215&pageContent=help
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Tab Option and Description 

 

 

 

Example of “Separate” Frequency Visualization: 

 

Notes on Frequency Selection 

When there are multiple frequencies selected, DataInsight-Web works like this: 

Examples 

A, Q, M frequencies are selected: 

Selected time: 2000M2 - 2001M2 

 

Periods selected: 2000M2, 2000M3, 2000Q2, 2000M4, 2000M5, 2000M6, 2000Q3, 
2000M7, 2000M8, 2000M9, 2000Q4, 2000M10, 2000M11, 2000M12, 2001, 2001Q1, 
2001M1, 2001M2 

Selected time: 2000M10 - 2001M1 
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Tab Option and Description 

 

Periods selected: 2000Q4, 2000M10, 2000M11, 2000M12, 2001, 2000Q1, 2000M1 

Selected time: 2000M1 - ... 

 

Periods selected: 2000, 2000Q1, 2000M1, 2000M2, ... 

Therefore, if the selected period is also a beginning of the less frequent period, that 
period will also get selected (e.g. 2000Q1 will also include 2000, 2000M4 will also 
include 2000Q2, when 2000M1 includes Q1 and 2000 as a whole).  This only behaves 
like this if the less frequent period is available and you select it. 

Start Date – End Date 

Select the time span, by year, for your data. 

Show Functions in Columns 

 

Toggle to show and hide functions in columns. 

Show Empty Rows 

 

Toggle to show and hide empty rows. 

Output Currency 

The currencies in which you would like your results expressed. Selecting “Local 
Currency” will display data for each country in its local currency (e.g. United Kingdom 
data will appear in pounds, China data will appear in yuan, etc.) You can select as many 
currency types as you want for your output. 
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Smart Datagroup Criteria Selection 

When you need to reuse any of the criteria frequently, smart datagroups have a method of 
remembering them for easy selection, every time you run a report. Each criteria node offers a way for 
you to group, aggregate, or create formulas using selected components and to save these custom 
criteria for subsequent use. 

You make your selections in the “Available Criteria” panel and they appear in the “Selected Criteria” 
panel.  

Working with Custom Criteria (below) gives information about the “My” criteria nodes of the 
selection trees. 
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The Context Menu 

The right-click context menu offers quick ways of working with the selection tree. 

 

Checking and un-checking all next level options require you to highlight a parent node first and then 
click on the appropriate menu option. You can see how this works in the example above. As the 
system selects the sub-nodes for you, those selections appear in the “Selected Criteria” area 
automatically. 
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Expanding and collapsing the various branches of the tree are also highlight-and-select processes. 

 

Working with Custom Criteria 

When you need to reuse any of the criteria frequently, smart datagroups have a method of 
remembering them for easy selection, every time you run a report. Each criteria node offers a way for 
you to group, aggregate, or create formulas using selected components and to save these custom 
criteria for subsequent use. 

Custom Criterion Icons 

There are three action icons to use in the “My” criteria area. 

Icon What it does… 

 Allows you to group, aggregate, and apply formulas to your custom criteria items. 

 Allows you to modify your previously created custom criteria. 

 Allows you to delete your custom criteria. 
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Adding a Custom Criterion to the Tree 

To create a custom concept, geography, or industry: 

1. Click on the boxed plus sign to the right of the top node in that dimension, “My Concepts” for 
example. 

 

2. A “My Concepts” dialog appears for your selections. Select the type, find your selections in 
the tree, name your concept, and click “Save.” 

 

Guide to “Types” 

Group: Two or more selections that make up a unit. 

Aggregate: A unit of two or more selections, taken into account as a whole, by using a 
mathematical operator on the components. 

Formula: A unit of two or more selections, made into an expression, by using a customized 
formula on the components. 
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3. Your custom criteria will be available under the “My” node for subsequent sessions of the 
smart datagroup. 

 

Modifying or Deleting a Custom Criteria Selection 

To modify a custom concept, geography, or industry: 

1. Click on the “Edit” icon to the right of the custom criteria that you want to modify. 

 

2. The “Edit Custom Concept” dialog appears for you to make your changes. Click “Save” to 
complete your modification. 

 

To delete a custom concept, just click on the “Delete” icon to the right of it. 
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Defining Groups or Aggregates, and Applying Formulas 

“My” criteria nodes allow you to customize your selections and save them for use whenever you 
access the smart datagroup again.  

 

To start the process, click on the plus icon to the right of your “My” criteria node and a “Create 
custom…” dialog appears for your selections. 

 

Creating Groups 

Creating a group is the simplest way to put different tree components together. Just click on your 
selections (or use the right-click context menu to select them), name the group, and click “Save.” 

Once saved, your customized group will appear in your “My” criteria, marked with a “G” for easy 
identification. 
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Creating Aggregations 

To create an aggregation under concept, geography, or industry: 

1. Select “Aggregation” as the type, find your selections in the tree, select your aggregation 
method, name your concept, and click “Save.” 

 

2. Your custom criteria aggregation will be available under the “My” node for subsequent 
sessions of the smart datagroup. It will be marked with an “A” for easy identification. 
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Creating Formulas 

To create a custom concept, geography, or industry with a formula as part of it: 

1. Select “Formula” as the type. 

 

2. Drag and drop your components into the Custom Formula textbox. Place your cursor 
between each component and either click on the appropriate button or type in the operator. 

3. Click on the Check Formula button to verify the validity of the formula you created and if the 
system confirms that your formula is valid, a green check will appear to the right of the 
formula textbox. 

 

If you see a circled red exclamation mark, adjust the formula and check it again. 
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4. Name your custom criteria and click “Save.” 

 

5. Your custom criteria with formula will be available under the “My” node for subsequent 
sessions of your smart datagroup. It will be marked with an “F” for easy identification. 

 

User Defined Calculation Order 

Calculation order is very important in your custom formula. When you define two or more calculations 
using custom components, the order in which they are carried out is the order in which you defined 
the calculations. In some cases, you may need to modify the calculation order to obtain correct 
results.  

For example, if you wanted to use the result obtained from calculating two formulas to calculate the 
value of a third one, the first two formulas must be calculated together first to obtain the correct final 
results.  
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Formula Examples: 

If you create your formula like this: 

 

This will appear in your preview: 

 

If you create your formula like this: 

 

This will appear in your preview: 
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Generating Smart Datagroup Reports 

 

Once your select your smart datagroup criteria, use “Export” to open a smart workbook in Excel.  

You can also refresh your data from within Excel unless you have set your Preferences or Settings 
to create non-refreshable workbooks (on the Advanced tab). 
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Formatting Options 

You will find the formatting options by clicking “Preferences” or “Settings” and then going to the 
“Format” tab there. (See Preferences and Settings for information about the “Format” tab.) 

 

Note: that forecasted data can be highlighted for easy recognition. 

Smart Workbook Options 

These powerful options for smart workbooks are only be available for subscribers to Smart 
Datagroups. (See Smart Workbook Preferences and Settings for information about them.) 

Refreshing a Smart Workbook in Excel 

You can update your Smart Workbook in Excel 2003 using “External Data” toolbar and in Excel 2007 
using the “Data” tab. 

If your Smart Workbook contains one sheet, your data will be refreshed within that workbook.  If your 
Smart Workbook contains multiple sheets, the data will be refreshed in a new read-only workbook, 
which you can save under a different name to be able to modify it. 

For more information, see the Generating Smart Datagroup Reports section of this guide. 
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Accessing the External Data toolbar in Excel 2003 

To display the External Data toolbar in Excel 2003, if it does not appear in the Excel toolbar area, 
use the View > Toolbars > External Data menu options. 

 

 

Accessing the Refresh All Feature in Excel 2007 

To refresh the smart workbook data in Excel 2007, use the “Refresh All” option on the Data tab. 

 

Refreshing the Data in Excel 2003 and 2007 

To refresh the data in a smart workbook in Excel: 

1. After making modifications or opening a previously saved smart workbook, click the “Refresh” 
button on the External Data toolbar in Excel 2003, or click on “Refresh All” on the Data tab in 
Excel 2007, to pull in the latest data. 

 

OR 
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2. (For Excel 2007 only) When you export a Workbook to Excel 2007 you will see a Security 
Warning alert.  Click “Options,” click “Enable this content,” and then click “OK.” 

 

3. Login with your MyInsight credentials. You only have to do this once per Excel 2003 or 2007 
session. 
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4. If you exported a smart workbook containing a single tab, current data will be pulled in and 
the refresh process will be complete. 

If you exported a smart workbook containing multiple tabs, a download link will display. Click 
it ONCE as it indicates and go on to step 5.  

 

5. Click “OK” to open the refreshed copy of your workbook. 
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A status screen will appear. 

 

6. Current data will appear in an updated, read-only copy of your workbook (if it has multiple 
tabs). 

 

7. Save the [Read-Only] copy under a different workbook name and it will be editable. 

Note:  If you delete rows or columns of data after exporting your data to Excel, these will 
reappear after you refresh. 

Using the Smart Datagroup Report Wizards 

The report wizard walks you through the process of creating a report for a Smart Datagroup and, 
since the selections offered within each wizard are specific to that datagroup, using this tool makes 
report generating both efficient and simple for you.  Additionally, you can export your report to Excel 
or save your report as a smart workbook, where data is automatically refreshed as new data become 
available. 
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Appendix A: Smart Datagroup FAQs 
Below you will find a list of many frequently asked questions and answers about Smart Datagroups 
and Smart Workbooks.  

• What is a Smart Datagroup?  

• How do I set Default Settings for my Smart Workbooks?  

• How do I create my own Custom Geography, Concept or Industry?  

• Can I apply functions to the data in my Smart Datagroup?  

• How can I create a report with one Concept in Percent Change (PCH) and all the 
concepts in Base Value?  

• I've changed the date range for my report, but the new dates are not reflected in the 
Preview data display table?  

• Can I display a report in more than one currency?  

• How do I rearrange the order of the rows in my report?  

• How do I rearrange the order of the columns in my report?  

• How can I organize the data in my report by Geography, Concept or Industry?  

• Can I change the layout of the Criteria panels and data Preview display?  

• How do I refresh my Smart Workbook in Excel? 

What is a Smart Datagroup? 

A Smart Datagroup is a categorized data set designed to support enhanced features for additional 
analytics such as currency conversion and rebasing, multi-dimensional data display sorted by user 
defined criteria and statistical ranking. 

How Do I Set Default Settings for my Smart Workbooks?  

Click on the “Preferences” button to modify and save Global Preferences. The Smart Workbooks tab 
options are preferences that apply only to Smart Workbooks created using the Smart Datagroup 
navigation, the WIS Report Wizard and the WIS Ranking Wizard.  

How Do I Create my own Custom Geography, Concept or Industry?  

In the Smart Datagroup Geography, Concept or Industry criteria selection drawer, click on the '+' to 
the right of the top node (i.e., My Geographies, My Concepts or My Industries) to access the screen 
to define custom groups. 

For example, to create your custom geography, click on the plus sign to the right of the My 
Geographies node. This will open the Create Custom Geographies screen, where you can define a 
Group of Countries and optional Aggregation Method or Custom Formula and name your custom 
geography. After saving your custom geography, it will appear in the My Geographies node in the 
Geography Criteria tree. For more information, see Smart Datagroup Criteria Selection .  
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Can I Apply Functions to the Data in my Smart Datagroup?  

Once you have selected your criteria, click on the Functions button at the bottom right of the screen. 
You can apply Percent Change, Moving Average and/or Compound Annual Growth rates to the data 
in your report. Selected functions will be applied to all the data in your report.  

How Can I Create a Report with One Concept in Percent Change (PCH) and all the 
Concepts in Base Value?  

After selecting your Concepts, you can apply functions to specific Concepts in the Selected Criteria 
panel. Simply right-click on any Concept and check the function you would like applied to that 
Concept.  

I've changed the Date Range for my Report, but the New Dates are not Reflected 
in the Preview Data Display Table?  

After changing Smart Datagroup options on the bottom of the screen, you need to click the Refresh 
button to apply these changes. The word Preview in the display pane title bar has an asterisk next to 
it (i.e., Preview*), to represent when a refresh is needed.  

Can I Display a Report in More than One Currency?  

You can display your data in single or multiple currencies. Click on the Preferences button and go to 
the Smart Workbooks tab, to modify the Output Currency for your report. All of your Selected Criteria 
will be displayed in the currency(s) you have selected.  

How Do I Rearrange the Order of the Rows in my Report?  

After selecting your criteria, you can rearrange the order for any Concept, Geography or Industry by 
dragging and dropping them within the tree in the Selected Criteria panel. The order reflected in the 
tree will be the order of the rows in your report. 

How Do I Rearrange the Order of the Columns in my Report?  

Currently you cannot rearrange the order of the columns in your report.  

How Can I Organize the Data in my Report by Geography, Concept or Industry?  

When the Regular radio button in highlighted, you can use the Group by drop down list to organize 
the data in your report by Geography, Concept or Industry. Additionally, you can further group the 
data by sheets in the workbook by using the 'Sheet by' drop down list.  

Alternatively, you can also rank the data, by clicking on the Ranking radio button. You can rank by 
Geography, Concept or Industry and select a ranking criterion of either End Date, Difference, Percent 
Change or Compound Annual Growth Rate.  

Can I Change the Layout of the Criteria Panels and Data Preview Display?  

In the upper right-hand corner of the Smart Datagroup display panels there are three icons to modify 
the display in Tab Mode, Stacked Mode or Side-by-Side Mode. For examples of the layout for each of 
the options, see Previewing Smart Datagroup Layouts.  
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How Do I Refresh my Smart Workbook in Excel?  

You can update your Smart Workbook in Excel 2003 using “External Data” toolbar and in Excel 2007 
using the “Data” tab. If your Smart Workbook contains multiple tabs, the data is refreshed in a new 
workbook. For more information, see Refreshing a Smart Workbook in Excel.  

 

 

 


